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INTRODUCTION
This leader’s guide is designed to permit you to use the accompanying training program in 
several different ways. Along with the program, you’ll find Training Points and a PowerPoint® 
slide presentation. These slides can assist you in the presentation of the material and tailoring 
the training to your facility’s needs. Illustrated employee handbooks are also available for use 
with this program. They may be distributed to participants as a helpful note-taking tool and 
for future reference. Contact Coastal if you would like to review or order handbooks.

This program is designed for a wide range of applications and work environments. As 
an instructor, it is recommended that you tailor the program to your facility’s needs by 
incorporating specific information unique to your situation and relevant to your participants 
and location. This leader’s guide is separated into sections on preparing and presenting the 
session. Exactly how you choose to teach the class is up to you. If you are a new instructor, it is 
recommended that you follow the program as indicated in this guide.

About This Program
Bloodborne Pathogens: Fast Facts for Schools gives the details about bloodborne pathogens 
(BBPs) in a fast and entertaining format. Host Kelley Davis highlights 14 fast facts you need to 
know about BBPs to meet annual training requirements. Kelley also provides a few fast tips on 
how to protect yourself from acquiring a BBP. 

The program is 15 minutes long and can be viewed straight through or paused at the 
section headings to allow discussion during viewing. Recommended discussion points and 
demonstration areas are identified throughout the Program Outline section of this   

leader’s guide.

Training Materials
You will need the following in order to best present an effective training session:

The training program Bloodborne Pathogens: Fast Facts for Schools

An employee handbook for each participant

Training room located where there are few distractions

Television with DVD/VCR player depending on the video media

Laptop or other computer to project the PowerPoint® presentation, and a screen or blank 
wall for adequate viewing

The PowerPoint® presentation 

Notepads and pencils

Chalkboard, flipchart or dry-erase board with appropriate markers.
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Preparation
Prior to the session, you should do the following:

Determine your audience. Are they new hires or experienced employees? It is 
recommended that you restrict your audience to each type of employee separately. If 
that is impossible, make a special effort to keep all employees involved throughout the 
training session.

Schedule the equipment. Work closely with the person who will be arranging the 
room, equipment, supplies and participants.

Schedule the time for the course. Participant retention will be greatest in the 
mornings or the beginning of the shift.

Preview the program, handouts and Program Outline. Decide how you will 
show the program. Will it be viewed straight through or will you stop for discussion? 
The DVD version has a menu screen which allows you to select various chapters. The 
Program Outline section of this leader’s guide indicates the chapters. 

Familiarize yourself with the TV and DVD/VCR player. This will allow you to avoid 
having to fumble with the controls. 

Decide how you will use the PowerPoint® presentation. You may refer to it at 
stopping points or go through it all at once at the end for review purposes. You may wish 
to customize it and use it as stand-alone training.

Determine facility policy on testing employees. A quiz is provided at the back of this 
leader’s guide, but you may want to consult your facility’s rules prior to using it.

Rehearse your presentation. Practice using the training aids and conducting any 
demonstrations. Make notes and write down any additional points you plan to discuss.
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Presentation Tips

Overcoming anxiety

The best way to overcome anxiety about speaking before a group is to be prepared. Although 
it is natural to feel nervous, your sweaty palms will disappear once you’re focused on what 
you’re saying – especially if you have a well-prepared plan.

As a training professional, you’re certainly concerned about the welfare of your participants. 
Focus on what you want people to understand and your presentation will evolve naturally. 
Remember, trainers and participants are on the same side. By staying focused, you’ll forget 
you were nervous in the first place!

Choosing your vocabulary

Don’t lose your audience by using sophisticated words they may not understand. Instead, use 
the same words you would use if you were speaking to each person individually.

Getting rid of the “umms”

One of the most common mistakes a speaker makes is saying “umm” when thinking about 
the next point to be covered. Be confident and know the subject you are presenting. Don’t be 
afraid to use silence while you think about what you are going to say next. The silence is really 
not that long, and you’ll gain credibility because the audience will see you are in control and 
concerned that the information presented is correct. 

Controlling the speed and tone of your voice

You will put your audience to sleep if you speak too slowly, but they won’t be able to keep 
up with the content if you speak too quickly. Speak to your audience as if you are having a 
conversation with each one individually. About 150 words per minute is the best speed.

Avoid a monotone voice. Vary your voice’s pitch, volume and tone often – especially when 
making a particular point. Adding emotion to your presentation will keep your audience 
attentive and help them to learn better.

Sticking to the schedule

Begin class on time and restart the session promptly at the end of each break. Explain that 
except for emergencies, messages will be taken for participants during the session and will be 
distributed at the start of each break.

Asking for questions

There is no better way for a trainer to gauge how well his audience is learning than by 
listening to their questions. Ask for and encourage questions throughout the session. Be 
prepared to answer all types of questions, but don’t be worried if you don’t know the answer. 
Simply say, “I’m not sure of the answer, but I’ll find out and get back to you.” Then, after class, 
make sure you do find the answer to the question and give it to the person.

http://www.coastal.com
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TRAINING SESSION OVERVIEW
Giving the Quiz
Prior to the session, perhaps even a few days beforehand, pass out the Quiz for employees to 
complete. This will give you an idea of how much they already know. Administering the Quiz 
early will help you tailor the training session and show you areas that should be emphasized. 
If you decide to administer the Quiz at the beginning of the training session, read over the 
responses while participants watch the program.

At the end of the session, have them again complete the Quiz. Compare the results to the 
previous quiz immediately and report on any conclusions you make. You may want to meet 
later with each person individually to discuss his or her particular results.

Presentation Outline

Introduce yourself and the session. Begin with a brief explanation of how the session will 
be beneficial to both the participants and the facility.

Use an “icebreaker.” True stories relevant to the topic will help relax the group.

Explain the desired outcome of the session. When the participants complete this session, 
they should:

Know the bloodborne pathogens (BBPs) of primary concern.

Understand that everyone is a potential carrier of BBPs.

Know that the risk of becoming infected is minimal, but still possible.

Understand how BBPs are transmitted.

Know how to protect oneself from getting a BBP.

Overview the session. Explain to the group:

Why the session is being conducted

When questions may be asked

How the program will be viewed – either straight through or in segments to allow for 
discussion

What to expect

Where they will be able to use this information specific to your facility.

Introduce the program. Point out what the participants should look for. If portions of the 
program are inappropriate for your audience, be sure to inform them. 

Make sure everyone can hear and see adequately.
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PROGRAM OUTLINE
Introduction
This section explains the reason annual training on bloodborne pathogens is important. 

Key Points:

The concern for exposure to BBPs is real.

While the chance of getting a BBP is minimal, it is still possible.

Definition/The Usual Suspects
These sections explain what bloodborne pathogens are and which ones are of primary 
concern. 

Key Points:

Bloodborne pathogens are a disease-causing organism found in the blood and 
certain body fluids of an infected person.

You can’t tell that someone is infected just by looking at him or her.

Always treat blood and body fluids as infected material and take steps to protect yourself.

There are three BBPs you need to be aware of: HBV, HCV and HIV.

HIV attacks a person’s immune system, eventually destroying their ability to 
fight infection.

As many as 30% of those infected with HBV and 80% of those with HCV may not show 
signs or symptoms.

HBV and HCV are detected through a blood test. There is a vaccine available to 
protect you against HBV; however there is no vaccine for HCV. 

Discussion Topics:

Explain how each of the three BBPs affects the body.

Discuss symptoms associated with each BBP.

Explain why it is important to take precautions against exposure.

Transmission/Doorways 
These sections discuss how BBPs are transmitted and the common ways you may be infected.

Key Points:

HIV, HBV, and HCV are all transmitted in the same way through contact with 
an infected person’s blood, body fluid containing visible blood or through sexual 
transmission.

In the school environment your chance of becoming infected is very small, but it 
could happen.

Your skin provides a natural protective barrier against bloodborne pathogens.

The virus needs a “doorway” into the body, such as through unprotected sex, sharing 
a needle with an infected person, a cut, scratch, razor nick, skin abrasion, dermatitis 
or acne.
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It’s important to know that even dried HBV can survive on surfaces at room temperature 
for a least a week.

Discussion Topics:

Discuss how BBPs are transmitted.

Explain that even though the risk of acquiring a BBP is low, precautions still need to 
be taken.

Exposure Control Plan/Everyone has a BBP
These sections explain that your school has a plan to handle exposure incidents and that you 
should consider everyone a potential carrier of BBPs.

Key Points:

Your employer has an Exposure Control Plan which is a requirement of the Occupational 
Safety and Health Administration (OSHA) and will list the potential hazards of each job 
and explain how to reduce your risk.

Consider every person a possible carrier of a bloodborne pathogen and to treat his or her 
blood or body fluids as if they were infected.

Discussion Topic:

Discuss the Exposure Control Plan.

Bleeding Emergency/Glove Removal
These sections describe how to deal with someone who is bleeding and how to properly 
remove gloves.

Key Points:

When assisting someone who is bleeding protect yourself first by putting on gloves.

You should always use disposable latex or vinyl gloves when dealing with blood.

Make sure to cover cuts or skin abrasions on your hands with bandages before putting 
on the gloves.

Follow the correct procedure on removing gloves safely.

After removing the gloves, the use of an alcohol-based hand sanitizer is also acceptable, 
but you should still wash your hands as soon as possible.

Discussion Topics:

Discuss what to do when helping a person who is bleeding.

Explain why you should.
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Resuscitation/Wardrobe Malfunctions/Clean-up
These sections discuss some additional precautions you should take to protect yourself from 
exposure to BBPs.

Key Points: 

If you need to give mouth-to-mouth resuscitation, protect yourself by using a mechanical 
respirator or a pocket mask.

If any of your protective equipment is penetrated by blood, remove the item and replace 
it immediately.

Always wear gloves to protect your hands and a smock to protect your clothing.

Dispose of all materials according to your school’s policy.

Discussion Topic:

Explain why it is best to use a mechanical respirator or pocket mask when giving mouth-
to-mouth resuscitation.

No Hands/Garbage Removal/ Potential Exposure
These sections explain other potential exposure sources.

Key Points:

When cleaning up contaminated sharp objects, such as glass, use a broom and dustpan. 
Never use your hands.

If you empty garbage cans or laundry bins, always pick up and carry bags by the top.

If you think you’ve been exposed to HIV, HBV or HCV–Do not panic!

 Your employer will advise you about testing, counseling and any follow-up steps.

Discussion Topics:

Discuss the proper way to clean up broken glass.

Explain the procedures to follow if you think you’ve been exposed to a BBP.

Quick Tips
This section highlights some last minute tips to help you stay safe.

Key Points:

Keep soiled hands away from your eyes, nose and mouth.

Always wash your hands before eating, drinking, smoking, handling contact lenses, or 
applying cosmetics or lip balm.

Wear gloves whenever you may be exposed to bloodborne pathogens.

When assisting someone who is bleeding, try to get the person to stop the bleeding by 
using direct pressure.

Discussion Topics:

Explain the importance of good hand hygiene.

Discuss how to get the victim to assist in stopping the bleeding.
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QUIZ 
Circle the correct answer.

True or False –  In the school environment, your risk of getting a BBP is minimal but 
still possible.

True or False – Most people show signs or symptoms that indicate they have a BBP.

True or False – The three BBPs of concern are HIV, HBV and HCV.

True or False – Human Immunodeficiency Virus (HIV) affects the liver and kidneys. 

True or False –  All three BBPs are transmitted in the same way; through contact with 
an infected person’s blood, body fluid with visible blood or through 
sexual transmission. 

True or False – Dried HBV can survive on certain room surfaces for up to one week.

True or False –  When assisting someone who is bleeding, consider the person a potential 
carrier of a BBP.

True or False –  After removing the gloves, the use of a hand sanitizer is sufficient and 
you won’t need to wash with soap and water. 

True or False –  You don’t need to wear gloves if you think the person your assisting is 
disease free. 

True or False –  If you think you’ve been exposed to a BBP, don’t panic. Your employer 
will advise you on testing, counseling and follow-up steps needed.

1.

2.

3.

4.

5.

6.

7.

8.

9.

10.
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ANSWER KEY 
True.

False.  Most people don’t show signs of a BBP infection, so you can’t look at someone and 
tell if they are infected.

True. 

False. The immune system is affected by HIV. 

True. 

True.

True. 

False.  If you run the chance of exposure to a BBP, you should always wash with soap 
and water as soon as possible after removing the gloves. Washing with soap and 
water is still the most effective at protecting you from becoming infected. 

False. Always wear gloves and consider everyone a potential risk.

True.

1.

2.

3.

4.

5.

6.

7.

8.

9.

10.
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CUSTOMIZING A POWERPOINT® PRESENTATION
The PowerPoint® presentations included on the Coastal DVD and CD products are customizable 
when used on a computer loaded with Microsoft PowerPoint® software. (Note: In the following 
instructions, “click” implies a click with your left mouse button. If a “right” click is necessary, it 
will be so indicated.) Microsoft PowerPoint® has many features. The following steps will help you 
customize our presentations quickly.

To customize a presentation:

If the “Customizable Version” icon is displayed on the landing screen, click on this option. If this 
option is not available, click on the PowerPoint® presentation to open it.

Save this presentation to another location, such as your hard drive or a folder on the network. You 
will make your customizations on the saved version.

To add, copy, hide or remove a slide, or to change the order of the slides in    
the presentation:

Click on “View” on the menu bar.

Click on “Slide Sorter” from the “View” menu. Or, under the “Normal” view, you may use the 
“Outline” on the left side of the screen.

To add a slide, place your cursor in front of the slide where you want to add a slide. Click on “Insert” 
on the menu bar. Then, click on “New Slide” on the “Insert” menu. Or, click on the “New Slide” tool 
on the tool bar. Choose a slide format to fit your desired content, and follow the prompts given.

Sometimes it’s easier to copy a slide, and then change the content of the slide than to create a 
new one. To copy a slide, click on the original slide. Click on “Edit” on the menu bar, and choose 
“Duplicate.” A new copy will be created to the right of the original slide. Or, click on “Edit” on your 
menu bar, and choose “Copy.” 
You may then “Paste” the slide wherever you want it to appear.

To hide a slide from your presentation, but to keep it for future use, right click on the slide you wish 
to hide, and choose “Hide Slide” from the menu. Or, click on the “Hide Slide” tool on the tool bar. 

To remove a slide from the presentation, click on the slide you want to remove. Click on “Edit” on 
the menu bar. Then, click on “Delete Slide” on the “Edit” menu. Or, click on the slide, and press the 
“Delete” key on your keyboard.

To change the order of the slides in the presentation, click on the slide to be moved and while holding 
the mouse button depressed, drag the slide to its new location. Release your mouse button to place 
the slide.

If you wish to change or remove the animation effect as you move from slide to slide:

Double click on the slide you want to change the animated transition on.

Double click on the text box of the slide. A border and white handles appear around the text box. 

Click on “Slide Show” on the menu bar. Then, click on “Preset Animation.” To turn off the effect, 
choose “Off.” If you wish to change the effect, there are many options to consider.

To edit content of any slide:

Double click on the slide you want to change.

Double click on the text box of the slide. A border and white handles appear around the text Type the 
desired changes.

Remember to save any changes made to your presentation! 
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  This leader’s guide is not intended as a substitute for first-hand knowledge of the applicable 
regulations. As a developer of high quality training materials, Coastal emphasizes the spirit 
and intent of OSHA regulations and other regulatory bodies..

This guide is designed to provide accurate and authoritative information regarding the 
subject matter covered. Sources for this information are believed to be reliable. Because of 
the possibility of human error, the publisher does not guarantee its accuracy, adequacy or 
completeness. Coastal is not responsible for any errors, omissions, misprinting or ambiguities 
contained herein or for the results obtained from use of such information. If legal advice or 
other expert assistance is required, the services of a competent professional should be sought.

This leader’s guide is one of a series of print materials, video, interactive CD-ROM, Web-
based and DVD programs produced by Coastal Training Technologies Corporation. Each 
product is the result of painstaking analysis, design, development and production by the 
instructional designers and technical specialists on our staff.

Our catalog is constantly being revised and expanded, so we would appreciate any   
comments on current titles or suggestions for future ones. For further information on 
any Coastal product, or to receive a free catalog, call Coastal Training Technologies Corp. 
(Virginia Beach, VA) at 800-  695-0756 or send a FAX to 757-498-3657. Visit us on the Web  
at www.coastal.com. 

This guide is for educational purposes only. Nothing herein is to be regarded as indicating 
approval or disapproval of any specific practice or product.

Copyright © 2008 Coastal Training Technologies Corp. Purchasers and renters may copy the 
Quiz found in the leader’s guide when they are used in conjunction with the program. Any 
other part of this product may not be copied by any means or for any reason without the 
written permission of Coastal Training Technologies Corporation. All Rights Reserved. 
Created in U.S.A.
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